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Thank you for purchasing GB-580. We sincerely hope you to enjoy using this high technology GPS device. 

For fully understand the functions and features of GB-580, please read the user manual before you get 

started. 

 

1. Introduction and Features 
1.1 Introduction 

GPS cycling computer for cyclist usage will provide more analysis ability in this platform. Use barometer 

to support GPS on virtual statistics and atmosphere changes. Cycling enthusiast can monitor the slope 

changes with map trace and altitude reading on the analysis application. For enthusiast, GB-580 will also 

provide accurate training information like pressure, slope, heart rate, cadence, more advanced features, 

etc. Enthusiast will have more fun while in training with this device. Indeed, for GB-580P model, it 

embedded pressure sensor, 2.4GHz ANT protocol and electrical compass. Enthusiast can upon personal 

preference to configure device to achieve their target of training performance.  

1.2 Features 
The main features of GB-580: 

 Slim type compact and watch design 

 Built-in SiRF Star III LPx high performance GPS chipset. 

 High resolution display embedded, which performs distinct display at outdoor without backlight. 

 Auto Zoom in/ out and auto orientation in guiding mode for easy operation. 

 Auto calibration algorithm of altitude by GPS without any complicated process. 

 Trainer mode: To provide different challenge modes to train themselves to improve performance. 

 Smart Tack Back to guide enthusiast without getting lost.  

 PC software to provide professional statistic analysis to improve performance. 

 Support clock mode and alarm function as TOD application. 

 Built in rechargeable Li-ion poly battery  

 Over 18 hours in operation 

 Support self training, route navigation and smart track back.  

 Embedded ANT 2.4GHz protocol which supports heart rate belt, cadence and speed sensor. (GB-580P) 

 Embedded electrical compass and high accuracy pressure sensor. (GB-580P) 

 

1.3 Heart Rate Sensor Installation Procedure (Only for GB-580P) 
Wear the Heart Rate Monitor  
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Outer side 

 

Heart rate sensor                             Transmitter           Heart rate sensor 

 

Inner side 

 

Moisten this side to your skin. You can wet the sensor to obtain a better reception of your pulse. 

 

1. Put one end of the strap through the slot of the heart 

rate monitor first. 

 

2. Wrap the heart rate monitor and strap around your 

chest. Adjust the heart rate monitor to be at the center of 

your chest.  

 

3. Adjust the strap to fit your chest and make it tight 

enough to prevent dropping while you are jogging.  

 

4. Put another end of the strap through the slot of the 

heart rate monitor to finish the wearing. 

 

 

 

 

 

 

 

5. Remember to select “scan” to paring heart rate 

monitor with your GB-580.  

[MAIN MENU] > [CONFIGURATION] > [ACCESSORIES] 

> [SENSORS] > [HEART RATE ] > SCAN. 
It will show HR instead of SCAN once paring was finished.
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1.4 Speed Sensor Installation Procedure (Only for GB-580P) 
1. Parts content list 

 

 

2.  

3.  

 

4.  

 

 

5.  The edge of magnet should be on the arrow 

 

 

 

 

 

 

In order to achieve the necessary 12mm or less 

install the transmitter and the magnet closer to the 

wheel hub 
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6. The image of sensor mount on the wheel 

 

 

7.  

 

 

8. Press button 

 

 

 

Green LED turn on 2 sec and also the LED will 

blinking for the first 10 times after sensor detect 

magnetic 
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9. Remember to select “scan” to paring speed sensor  

with your GB-580. It will show SP instead of SCAN once  

paring was finished. 

 

[MAIN MENU] > [CONFIGURATION] > [ACCESSORIES] 

> [SENSORS] > [SPEED ] > SCAN. 
 

 

 

Replace and change battery 
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1.5 Cadence Sensor Installation Procedure (Only for GB-580P)  
1. Parts content list 

 

2.  

 

3.  

 

4.  

 

5.   

 
 

6. The edge of magnet should be on the arrow 

 

7.  
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8. Press button 

 

 

 

 

 
 

 

Green LED turn on 2 sec and also the LED will 

blinking for the first 10times after sensor detect 

magnetic 

 

 

 

 

9. Remember to select “scan” to paring speed sensor  

with your GB-580. It will show CA instead of SCAN once  

paring was finished. 

 

[MAIN MENU] > [CONFIGURATION] > [ACCESSORIES] 

> [SENSORS] > [CADENCE ] > SCAN.  
 

Replace and change battery 
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2. Specifications 
Electrical and Mechanical Parameters General 

Number of Waypoint 100 100 

LAP 6000 6000 

Number of Track point 60000 60000 

Display Size 
Active Area : 29.94 * 32.75      
View Area : 32.34 * 34.85 

(H x W in mm.) 

Active Area : 29.94 * 32.75      
View Area : 32.34 * 34.85 

(H x W in mm.) 

Display type 4 Grayscales colors 4 Grayscales colors 

Resolution 128x128 Pixels 128x128 Pixels 

Waterproof Standard IPX7 IPX7 

Unit Size 70 x 49 x 18 (L x W x H in mm.) 70 x 49 x 18 (L x W x H in mm.) 

Backlight Display Single level Single level 

Operating temperature -10℃ to 60 ℃ -10℃ to 60 ℃ 

Humidity 5% to 95% Non-condensing 5% to 95% Non-condensing 

Voltage 3.7V for a rechargeable battery 3.7V for a rechargeable battery 

Battery 
Rechargeable 760mAh 

Lithium ion battery 

Rechargeable 760mAh 

Lithium ion battery 

Battery life 
GPS 3D fix, Backlight off – 18 hours 

GPS 3D fix, Backlight on – 14 hrs 

GPS 3D fix, Backlight off – 18 hours 

GPS 3D fix, Backlight on – 14 hrs 

Barometer N/A +/-1.5mbar 

E-Compass N/A 2 Axis +/-5 degree 

2.4G RF 
N/A ANT+ Sport Protocol, 3m transmission 

distance 

Interface Mini USB Mini USB 

GPS Parameters General 

GPS Chipset: 20 Channel 

Frequency: L1, 1575.42 MHz 

Code: C/A code 

Channels: 48 Acquisition and 12 Tracking 

Antenna Type: Built-in patch antenna 

Position: 2.2m CEP without DGPS 

Velocity: 0.1 m/s 

Time: 1 us synchronized to GPS time 

Default datum: WGS-84 

Reacquisition: 0.1 sec., average 
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Hot start: 1.5 sec., average 

Warm start: 32 sec., average 

Cold start: 34 sec., average 

Altitude: 18,000 meters (60,000 feet) max. 

Velocity: 515 meters/ second (1000 knots) max. 

Acceleration: Less than 4g 
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Button Description 

Power/ESC Press 2 seconds to turn on/off GB-580.  

When GB-580 is on, quickly press this button will turn on/off the backlight. 

Press and hold this button for 14 seconds to do hardware reset if the system is halted. 

In Menu mode, press ESC button shortly to escape from the current page and go back 

to the previous page.  

PG /ENTER Switch between the screens of Speedometer mode. 

Press 2 seconds to enter between Main Menu page Speedometer Page alternatively.  

In Main Menu page, press this button shortly as ENTER function.  

Switch between the screens of “Menu mode”, “Location mode”, “Speedometer mode” 

and “Map mode”. 

Up /Start/Stop 

 

To press UP to up scrolling as highlighting an item in Main Menu page. 

In Speedometer mode, press START button to start timer to get training. 

In Speedometer mode, press STOP button to stop timer in training. 

In Map mode, press for zoom in. 

 

Down/Lap/Save To press Down to down scrolling as highlighting an item in Main Menu page. 

In Speedometer mode, when timer is counting for training, press Lap button to create a 

lap. 

If timer is stop while in training, press SAVE button to save training. 

 

Power / Light/ Esc 

Page/ Enter 
Down/Lap/Save 

Up/ Start/ Stop 
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3. Main Menu 
This diagram presents all the available menu options for your quick look up. 

 

ACTIVITY 

ACTIVITY INFO 
TRAINING INFO 

DELETE ALL 

SETTING 

AUTO HOLD 

ALERTS 

TIME/DIST ALERT 

SPEED/PACE ALERT 

HEART RATE ALERT 

CADENCE 

SETTING 

CALORIES  

SPORT TYPE 

TRANING LEVEL 

EXTRA WEIGHT 

LAP SETTING 
 

 

DATA RECORDING 

 

 

 

TRAINER 

DIST / TIME 

DIST / SPEED 

SPEED / TIME 

RACE/ DIST 

YOURSELF 

MEMORY STATUS  

NAVIGATION 

ADD MAP MODE / REMOVE MAP MODE 

REMOVE COMPAS / ADD E-COMPASS 

ROUTES 

CREATE NEW 

LIST ALL 

DELETE ALL 

SAVE WAYPOINT 

FIND WAYPOINT 
LIST ALL 

DELETE ALL 

BACK TO START / STOP GOTO 

CONNECT TO PC 
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CONFIGURATION 

CONFIGURATION 

USER PROFILE 

PAGE SETTING 

SET PAGE 1 

SET PAGE 2 

SET PAGE 3 

SET PAGE 4 

SET LAP PAGE 

SET SYSTEM 

BEEPER 

TOD MODE 

DISPLAY 

BACKLIGHT 

LANGUAGE 

ORIENTATION 

UNITS 

TIME SETTINGS TIME FORMAT 

 TIME ZONE 

 DAYLIGHT SAVING 

ALARM 
FREQUENCY 

TIME 

ACCESSORIES 

SENSORS* 

HEART RATE* 

SPEED* 

CADENCE* 

SPEED/CADENCE* 

CARDIO SETTING* 

BIKE SETTING* 

BIKE* 

WEIGHT* 

WHEEL SIZE* 

BARO SETTING* 

CALBRATION*  

SEA LEVEL PRESSURE* 

CURRENT ALTITUDE* 

SET COMPASS*  

CALIBRATION* 

DECLINATION* 

FOLLOW BEARING* 

GPS SETTINGS 

WAAS / EGNOS 

GPS 

GPS INFO 

MAP MODE SET 
BIRD EYE VIEW/ DIRECT TO NORTH 

ZOOM IN / OUT 

FACTORY RESET 
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SYSTEM UPGRADE 

ABOUT PRODUCT 

Note: * is only available for P model 

 

4. Symbol Explanation 
 

 

 

Icon picture Description Indication 

 GPS status 

GPS status indicator 

 Flash: No signal  

 Solid: 3D fix 

 Solid with 1 bar: 3D fix with poor signal 

 Solid with 2 bar: 3D fix with good signal 

 Solid with 3 bar: 3D fix with strong signal

 timer icon 
When training is active, the icon will appear. When 

you stop the timer, the icon will be flashing.  

 Cadence sensor 
This icon will show up when device scanning the 

cadence / speed sensor 

 Clock alert 
This icon will show up when you set the alarm clock 

for WEEKEND, WEEKDAY, DAILY…or OFF 

 
Heart rate monitor 

indication 

This icon will show up when device scanning the 

heart rate monitor 

 
Battery capacity 

indication 
The remaining battery power 
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5. Antenna Introduction  

 

 

The GPS antenna is located in the lower 

part of the device. Let it face to the sky for a 

better reception. 

 

6. Getting Started 
6.1 Starting Up Your GB-580 
 

Press the Power button for 2 seconds to turn on the 

device. You will see the welcome screen displayed. 

Allow the GB-580 a short time to track satellites for the 

first time you use it. Take your GB-580 to the outdoor 

open space with a clear view to the sky and it will be easy 

to acquire satellite signal with a few seconds. If the 

device can't get 3D fixed, you can still press PG button to 

exit the Locating screen.  

System will pop up “RESET GPS” to ask you perform 

cold start if can’t get 3D fix for 3 minutes.  

To turn off your GB-580, press the Power button for 2 

seconds. 

If the system frozen, press power button for 10 seconds 

to do hardware reset. 
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6.2 Battery Charging Description 
 
GB-580 operates by a built-in Li-ion rechargeable battery. 

A battery icon shown on the left bottom corner of screen 

indicates the remaining battery power. 

To charge the battery: 

Connect one end of USB clip with your GB-580 and the 

other end with the AC adapter or USB port on PC. 
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7. Change the Page 
7.1 Switch different modes 
Short press ‘’Page/OK’’ to switch different modes  

 

                          

 

 

 

                                              

Custom Page1                                                   Custtom Page 4 

                   

 

 

 

 

 

                                                     

Custom Page2                                                   Custom Page3 

In Speedometer mode, press        

to Start or Pause timer 
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7.2 Setting Modes 
Long press ‘’PG/OK’’ around 2 seconds to enter setting modes and “ESC” to back to Speedometer mode or 

TOD mode. 

 

                                 

 

8. Activity 
8.1 Activity Info  
8.1.1 Training Info 
[[ACTIVITY] > [ACTIVITY INFO] > [TRAINING INFO] 

 

1. Use Up and Down button to scroll to the item you 

wish to display and press ‘’OK’’ button then all 

training data information will display: 

 

2. Use Up and Down to select the file you wish to check 

and press ‘OK’’ button, the training data information 

is shown on the screen. 

 
Information items are displayed: 

 Date and Time. 

 Total distance of this training. 

 Total calories you have burned. 

 Total time of this training. 

 Average speed of this training. 

 Fastest speed of this training. 

 VIEW? Display this training data on the screen. 

 TRACK BACK? You can track back to the BEGIN 

point or END point of this training route. 

 LAPS? View the LAP details on map mode. 

 DELETE? You can delete this training data. 

 

 
 

 

PG/OK 2seconds 

ESC 
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8.1.2 Delete All 
[MAIN MENU] > [ACTIVITY] > [DELETE ALL] 

 

You can delete all the training data stored in the device. 

 

 

 

8.2 Setting 
8.2.1 Auto Hold 
[MAIN MENU] > [ACTIVITY > [SETTING] > [AUTO HOLD] 

 

1. The Auto Hold function allows you to pause the timer 

automatically when you stop moving or your speed 

falls below a certain value. 

2. When in the stationary or within the specific speed, 

the data is not recorded. Thus the average speed 

and calories calculation could be more accurate. 
 

 

8.2.2-1 Alerts - Time / Distance 
[MAIN MENU] > [ACTIVITY > [ACTIVITY SETTING] > [ALERTS] > [TIME/DIST] 

1. Use Up and Down button to select the item and press 

OK to modify it. 

2. You can set the alarm to sound once when the 

specified time is reached, or repeat to sound on every 

specified time, or turn it off. 

3. You can set the alarm to sound once when you 

reached the specified distance, or repeat to sound on 

every specified distance, or turn it off.  

 

 

 

8.2.2-2 Alerts - Speed / Pace 
[MAIN MENU] > [ACTIVITY > [ACTIVITY SETTING] > [ALERTS]> [SPEED / PACE]  
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1. Use Up and Down button to select the item and press 

OK to modify it. 

2. You can set the alarm to sound when your speed or 

pace is above or below a specified value. 
 

 

8.2.2-3 Alerts - Heart Rate (GB-580P only) 
[MAIN MENU] > [ACTIVITY > [ACTIVITY SETTING] > [ALERTS] > [HEART RATE]     

 

1. Use Up and Down button to select the item and press 

OK to modify it. 

2. You can set the alarm to sound when your HR ZONE / 

CUSTOM setting is above or below a specified value 

or OFF alarm.  

 

8.2.2-4 Alerts – Cadence (GB-580P only) 
[MAIN MENU] > [ACTIVITY > [ACTIVITY SETTING] > [ALERTS] > [CADENCE]  

 
1. Use Up and Down button to select the item and press 

OK to modify it. 

2. You can set the alarm to sound on or off when your 

cadence is above or below a specified value. 

 
 

8.2.2-5 Setting 
 

You can choose the alerts methods as message/beeper or 

symbol/beeper 

 

 

 

8.2.3 Calories 
[MAIN MENU] > [ACTIVITY > [SETTING] > [CALORIES] 
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 Sport Type 

Select sport type from "Walking", "Hiking", "Running", 

"Biking" or "By Time" by press UP and Down button. 

To set the type in order to come out more accurate result. 

  
 

 Training Level  

Select training level depend on your personal condition and 

exercise strength, the default setting is Middle. To set the 

level in order to come out more accurate result. 

 

 

 Extra Weight  

Confirm the extra weight you carry and then input to EXTRA 

WEIGHT item. To set the value in order to come out more 

accurate result. 

 

System will calculate the calories consumption depending 

on the specified sport type. 

 

 

8.2.4 Lap Setting 
AIN MENU] > [ACTIVITY > [SETTING] > [LAP SETTING]  

 

You can select LAP trigger “by Distance” or "by Time" 

 

 

 

8.2.5 Data Recording 
[MAIN MENU] > [ACTIVITY > [ACTIVITY SETTING] > [DATA RECORDING ]  

 

 Record Data Points  

System is default to record one point for every second. This 

will create the most accurate record for your training activity. 

However, you can set a different interval to record the points. 
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 Recording Interval Setting 

You may base on different sport and strength to set the 

interval. In this way, you may get more accurate information 

for analysis and more stable to control Auto Zoom In and Out 

while in Track Back. The recommended values is: 

- Walking and Running: 1s 

- Cycling: 2s 

 

 

 Altitude Set (GB-580P only) 

Choose the information of altitude form GPS or Barometer 

sensor. It is recommended using barometer to get much 

reliable altitude information. Be aware of calibrating the 

pressure sensor before training.  

8.3 Trainer 
8.3.1 Dist / Time 
[MAIN MENU] > [ACTIVITY > [TRAINER] > [DIST/TIME] 

Set distance for 3 km and time for 15 minutes which means the virtual trainer will finish 3km within 15 minutes 

to compete with you. 

 

1. You could change DIST / TIME to set up your goal. 

 

2. Finished setting, press ‘’Up or Down button’’ to select 

‘’Start’’ and then press ‘’Enter button’’ to start. 

 

3. ENABLE ALERT ? you can select YES or NO to give 

you a alert. 

 

 

4. DO YOU RECORD RUNNING DATE ? If select YES 

the chronograph will start to record your training. 

 

5. When you reach your goal or have superior or poor 

performance to trainer, it will show good job / do 

harder next time 

 

6. If you have superior or poor performance to trainer, it 

will show ahead or behind distance to you.  
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8.3.2 Dist / Speed 
[MAIN MENU] > [ACTIVITY] > [TRAINER] > [DIST/SPEED] 

Set distance for 10 km and speed for 10 km/hr which means trainer will keep 10km/hr running for 10km to 

race with you. 

 

1. You could change DIST / SPEED to set up your goal. 

 

2. Finished setting, press ‘’Up or Down button’’ to select 

‘’Start’’ and then press ‘’Enter button’’ to start. 

 

3. ENABLE ALERT ? you can select YES or NO to give 

you a alert. 

 

4. DO YOU RECORD RUNNING DATE ? If select YES 

the chronograph will start to record your training. 

 

5. When you reach your goal or have superior or poor 

performance to trainer, it will show ahead or behind 

distance to you.  
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8.3.3 Speed / Time 
[MAIN MENU] > [ACTIVITY] > [TRAINER] > [SPEED /TIME ] 

Set speed 10km/hr and time 00:05:00 means trainer will keep 10km/hr running for 5mins to race with you. 

 

1. You could change SPEED / TIME to set up your goal. 

 

2. Finished setting, press ‘’Up or Down button’’ to select 

‘’Start’’ and then press ‘’Enter button’’ to start. 

 

3. ENABLE ALERT ? you can select YES or NO to give 

you a alert. 

 

4. DO YOU RECORD RUNNING DATE ? If select YES 

the chronograph will start to record your training. 

 

5. When you reach your goal or have superior or poor 

performance to trainer, it will show ahead or behind 

distance to you. 

 

 

 

 

   
 

 

8.3.4 Pace / Dist. 
[MAIN MENU] > [ACTIVITY] > [TRAINER] > [PACE/DIST] 

Set dist 10m/hr and pace 00:01:00/km means trainer will keep the specific pace to run 10km to race with you. 

 

1. Yu could change PACE/ DIST to set up your goal. 

 

2. Finished setting, press ‘’Up or Down button’’ to select 

‘’Start’’ and then press ‘’Enter button’’ to start. 
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6. ENABLE ALERT ? you can select YES or NO to give 

you a alert. 

 

7. DO YOU RECORD RUNNING DATE ? If select YES 

the chronograph will start to record your training. 

 

When you reach your goal or have superior or poor 

performance to trainer, it will show ahead or behind 

distance to you. 

 

 

 

   
 

 

8.3.5 Yourself  
 [MAIN MENU] > [ACTIVITY] > [TRAINER] > [YOURSELF] 

Select the previous performance training as workout. Trainer will base on your previous performance to race 

with you. 

 

List all training information. And select the training as 

workout to go for training. 

  

 

8.3.6 Memory Status 
[MAIN MENU] > [ACTIVITY] > [TRAINER] > [MEMORY STATUS] 
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You will see how many points left and the remaining time 

you can use. The remaining time depends on the period of 

your record setting.  

 

 
 

9 Navigation 
9.1 ADD MAP MODE / REMOVE MAP MODE 
[MAIN MENU] > [NAVIGATION] > [ADD/REMOVE MAP MODE] 

 

You can use this feature to display or not display the map 

mode. However, while the Map Mode is off, and you 

execute "Add map code " or ‘’Remove map’’ a waypoint, 

the Map Mode will be turn on again. 

    

9.2 Remove Compass 
[MAIN MENU] > [NAVIGATION] > [ADD/REMOVE COMPASS] 

 

You can use this feature to enable or disable compass 

page. It will show the direction and remain distance to 

target point and you can follow up to back. 

 
    

9.3 Routes 
9.3.1 Create New 
[MAIN MENU] > [NAVIGATION] > [ROUTES] > [CREATE NEW] 

 

1. You can add the waypoints to create your own route. 

Press OK button to insert a waypoint. 

 

2. Highlight a waypoint and press OK button for deleting 

this waypoint or insert another waypoint in above. 

 

3. In the first line of the screen, you can edit the name of 

, 



GB-580 
 

 
Page 29 

this route. When you are done with editing the route, 

press ESC button to save and exit.  

 

4. Select ‘’FOLLOW’’ to get training. It will guide you 

automatically. You may press ’’ENTER’’ or ‘’ESC’’ to 

go next or last waypoint  

 

 

 

 

9.3.2 List All 
[MAIN MENU] > [NAVIGATION] > [ROUTES] > [LIST ALL] 

1. Select the route you want to navigate, and select 

"FOLLOW?". You will be asked which point (start point 

or end point) to navigate. You will see your current 

position and destination point on the screen, and those 

nearby waypoints are also displayed. Press Up and 

Down button to zoom out and zoom in the map view. 

To press’’ ENTER’’ or ‘’ESC’’ will go next or last 

waypoint. 

2. Press PG button display the distance and time for you 

to reach destination on the right part of screen. The 

direction of destination waypoint is shown by the arrow 

sign of the compass. 

3. If you want to stop the navigation, press [MAIN MENU] 

> [NAVIGATION] > [STOP ROUTE].Select the route 

you want to delete, and select "DELETE?". This route 

will be deleted immediately. 
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9.3.3 Delete All 
[MAIN MENU] > [NAVIGATION] > [ROUTES] > [DELETE ALL]   

 

1. A confirmation dialog box will appear. 

2. Use Up and Down button to highlight "YES" and press 

OK. 

3. All routes data in memory will be deleted. 

 

9.4 Save Waypoint 
[MAIN MENU] > [NAVIGATION] > [SAVE WAYPOINT] 

  

1. You can save the current position. If the GPS position 

is fixed, it shows the longitude, latitude and elevation 

on the screen. 

 

2. Use Up and Down button to scroll to the item you wish 

to modify and then use the ‘’Enter button’’ to select and 

confirm. 

 

3. When you finish the modification, input a “enter sign” 

character or press the ‘’Esc /Lap button’’ to exit. 

 

4. Move highlight to "CONFIRM?" and press ‘’Enter 

button’’ . The location data will be stored in the 

memory 

 

 

 

 

 

9.5 Find Waypoint 
9.5.1 List All 
[MAIN MENU] > [NAVIGATION] > [FIND WAYPOINT] > [LIST ALL] 

 

1. Use Up and Down button to scroll to the Waypoint 

you wish to go to and press ‘’Enter button’’. 

 

2.  Highlight "GOTO?" item and press ‘’Enter button’’. 

 

3. You will see your current position and destination 
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point on the screen, and those nearby waypoints are 

also displayed.  

 

4. Press ‘’Page button’’ display the distance and time for 

you to reach destination on the right part of screen. 

The direction of destination waypoint is shown by the 

arrow sign of the compass. 

 

 

 
 

 

 

9.5.2 Delete All 
[MAIN MENU] > [NAVIGATION] > [FIND WAYPOINT] > [DELETE ALL] 

1. A confirmation dialog box will appear. 

2. Use Up and Down button to highlight "YES" and 

press OK. 

3. All waypoints in memory will be deleted. 

 

 
 

9.6 Back To Start /Stop GOTO 
[MAIN MENU] > [NAVIGATION] > [RETURN TO START / STOP GOTO] 

 

1. You can use this feature to navigate you back to the 

start point of the latest saved training data. 

2. The navigation screen is shown and you can follow 

the direction of arrow to go back to the start point.If 

you want to stop the navigation, press[MAIN MENU] 

> [NAVIGATION] > [RETURN TO START / STOP 

GOTO] 
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10.Connect To PC 
[MAIN MENU] > [CONNECT TO PC]  

If wonder to communicate to PC, you may follow the ways: 

1. System will pop up message to ask you “Want to connect to PC?” while cable is plugging. 

2. Select Connect To PC in Menu Mode for communicating. 

 

You can transfer the training data from GB-580 to your PC.

 

 

 

11 Configuration 
11.1 User Profile  
[MAIN MENU] > [CONFIGURATION] > [USER PROFILE] 

 

1. You can input your personal information in the user 

profile for getting more accurate information before 

trainning. 

2. The data fields include "username", "gender", "birth 

date", "weight" and "height". 

3. The system will do the calories calculation base on 

the information you provide. Please input the correct 

value.  

 

 

11.2 Page Setting 
[MAIN MENU] > [CONFIGURATION] > [PAGE SETTING]  

 

1. There are four custom pages and one Lap screen to 

show training information. You may set your 

preference for person training.  

 

2. There have five types of screen field could be choose 

for every page. 

 

3. Select the function coefficient you want then 
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press ’Enter button’’ to save setting. 

 

4. To select what information you want to show on the 

display for your training record. 

 

   

 

 

11.3 Set System 
11.3.1 Beeper  
[MAIN MENU] > [CONFIGURATION] > [SET SYSTEM ] > [BEEPER]  

 

You can set beeper on or off and accompany message 

only or both of KEY sound and Message. 

 

 
 

11.3.2 TOD Mode 
[MAIN MENU] > [CONFIGURATION] > [SET SYSTEM ] > [TOD MODE]  

 

You can choose OFF, 5 minutes, 10minutes. System will 

enter to TOD mode as clock while standby over the 

specific time. 

In TOD mode, you may press UP for 2 seconds to escape 

to normal operation mode. 
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11.3.3 Display 
[MAIN MENU] > [CONFIGURATION] > [SET SYSTEM ] > [DISPLAY]  

 

 

 Backlight  

Set the backlight to stay on or automatically turn off after a 

period of time once you press Power button to activate the 

backlight. 

 

 

 

 

 Language 

There are 5 different languages of User Interface, including 

"English", "Spanish", "Italian",’’ French’’ and "Germany". 

 

 

 

 

 Orientation 

Choose orientation with vertical or horizontal. This feature is 

upon personal preference for easy reading while in activity.

You also may follow the combination key “PG+DOWN” to 

rotate screen.  

 

 

 

  

 Units 

1. The measurement unit can be set as "statute" or 

"metric". 

2. The speed unit can be set as Pace (min/m, 

min/K) or Speed (mph, kph). 

 

 

 

11.3.4 Time Settings 
[MAIN MENU] > [CONFIGURATION] > [SET SYSTEM ] > [TIME SETTINGS]  
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 Time Format 

1. Use Up and Down button to scroll to the item 

and press OK to modify it. 

2. You can set the time to display in the 12 Hour or 

24 hour format. 

 

 

 

 

 Time Zone 

1. Use Up and Down button to scroll to the item 

and press OK to modify it. 

2. You can select your local time zone. 

 

 

 

 

 Daylight Saving 

1. Use Up and Down button to scroll to the item 

and press OK to modify it. 

2. You can select the daylight saving if necessary, 

and then system will display the correct time for 

you. 

 

 

 

 

11.3.5 Alarm  
[MAIN MENU] > [CONFIGURATION] > [SET SYSTEM ] > [ALARM ]  

 

You can set the alarm clock for WEEKEND, WEEKDAY, 

DAILY…or OFF. And then set up the time you want clock 

to ring you. 

 

11.4 Accessories (GB-580P only) 
11.4.1 Sensors 
[MAIN MENU] > [CONFIGURATION] > [ACCESSORIES] > [SENSORS]  

 

1. Use Up and Down button to scroll to the accessory 

intend to pair and use. 
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2. To perform scanning these four 2.4GHz sensors of 

training equipments. 

  

3. Once device is well paring, the display will show ‘’OK’’ 

information. 

 

4. Followed up, system will show HR/SP/CA/SC word 

regarding the well pairing equipment.  

 

 

 

 
11.4.2 Cardio Setting 
[MAIN MENU] > [CONFIGURATION] > [ACCESSORIES] > [CARDIO SETTING]  

 
You can select By AGE or CUSTOM to set up your heart 

rate zone or guiding Max heart is calculated by 220-age. 

The setting will be used for HR alarm. 

You may input them according MAX HR or Percentage 

format. 

 

 

 

 

 

 

 

11.4.3 Bike Setting  
[MAIN MENU] > [CONFIGURATION] > [ACCESSORIES] > [BIKE SETTING]  

 

 
You can set the bike weight and wheel size on this page. 

The setting will be used for cadence and speed sensor 

while be active. There are five wheels for setting. 
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11.4.4 Baro Setting 
[MAIN MENU] > [CONFIGURATION] > [ACCESSORIES] > [BARO SETTING]  

Before getting training, it is recommended to 

calibrate the barometer in order to come out reliable 

value of altitude. There are two way to calibrate: 

1. Auto Calibration: It is recommended to use. 

System will calibrate sensor upon GPS signal 

when the signal is reliable. It always calibrate 

one times after power on. 

2. Manually calibration; you may go on government 

weather bureau to get your local Sea Level 

Pressure and then put in. System will accord to 

the value to come out the current altitude.  

 

 

 

11.4.5 Set Compass 
[MAIN MENU] > [CONFIGURATION] > [ACCESSORIES] > [SET COMPASS]  

 
 Calibration  

Electronics compass can assist GPS and improve the 

unreliable problem from stationary. You have to calibrate 

before use that. You may follow instruction to calibrate. 

 
    

 
 Declination  

The practical magnet pole of Earth is ellipsoid, not ideal 

circus. You may manual input the declination value or set 

as auto calibration. It is recommended as AUTO. 
  

 

 Follow Bearing  

The bearing angle means the included angle between 

North and target point. You may perform as a real 

compass without GPS to reduce power consumption. 
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11.5 GPS Settings 
[MAIN MENU] > [CONFIGURATION] > [USER SETTINGS] > [GPS SETTINGS]  

 
 WAAS/EGNOS 

You can turn on/off the "WAAS/EGNOS" feature. 

 

 

 

 

 GPS 
The GPS function can be turned off for saving battery 

power. If the battery power is pretty low, the system will 

also ask you if you want to turn off the GPS function. 

 

 

 

 

 GPS Info 
Here you can see the positioning status of how many 

satellite signals are obtained and the signal strength. 
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11.6 Factory Reset 
[MAIN MENU] > [CONFIGURATION] > [FACTORY RESET]  

 

This feature allows you to restore the GB-580 back to 

factory default status. In another words, the training data, 

waypoint, and user profile will be erased.  

 

 

 

11.7 System Upgrade 
[MAIN MENU] > [CONFIGURATION] > [SYSTEM UPGRADE]  

 

1. Allow you to upgrade the firmware of GB-580.  

2. If you want to cancel the upgrade process, press 

Power + ESC button at the same time. 

 

 

 

11.8 About Product 
[MAIN MENU] > [CONFIGURATION] > [ABOUT PRODUCT]  

 

Display the firmware version information.  

 

 

 

12. Troubleshooting 
1.) Q: What should I do if the watch would not power on? 

    A: Press the  UP, OK, and Power  buttons at the same time. You will be able to turn it on in 

the firmware upgrade mode. Please follow the regular firmware update procedure. 

 

2.) Q: What should I do if the firmware upgrade fails? 

       Note: Do not power down your GB-580. 

    A: (1) Please go over the process again. 
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       (2) Choose the proper firmware file. 

 

3.) Q: After installing the software and opening it, a pop-up window shows up stating "The service 

is not ready." What should I do to resolve that? 

    A: Please close the program. Open it back again. The database will reset automatically. 

 

4.) Q: How can I uninstall the GS-Sport Training Gym Pro software? 

    A: (1) Utilize the uninstall function from the Windows Menu:  

    Start > Programs > Globalsat GS-Sport Training Gym Pro > Uninstall 

       (2) Use Add or Remove Programs from Windows Control Panel:  

    Go to Start > Control Panel > Add or Remove Programs. Search for GS-Sport Training 

Gym Pro, click on it to highlight, and press the Change/Remove button. 

 

5.) Q: Where can I download the files if I lost the CD-ROM? 

    A: Please go to this website: 

http://www.gs-sport.com/pro_dl.php?en_product_id=10&en_product_cnt_id=33 

 

6.) Q: How do I keep my current training records before upgrading the software version? 

    A: (1) Backup the database from this location: C:\Program Files\GlobalSat 

Technology\GS-Sport Training Gym Pro\Data\User. You can go ahead and uninstall the software. 

       (2) Copy and overwrite the database back to the corresponding folder. 

 

7.) Q: Why am I unable to upgrade the watch with the new firmware? 

    A: (1) Please check if the firmware file is correct. 

       (2) Verify it the watch is set to System Upgrade mode. 

 

8.) Q: Why does it show "PC COM PORT Error" when I tried to download the data from the device? 

    A: (1) Please check if the USB driver is installed or not. 

       (2) Connect the watch to your PC with the USB cable. 

       (3) Double click the GS-Sport Training GYM Pro' icon from the Desktop to start the 

application. 

       (4) In the Menu Bar, go to Settings > Configuration. Click the 　 can COM Port" button. The 

COM Port would be automatically scanned. 

 

9.) Q: Why is the device unable to receive a heart rate signal? 

    A: (1) Check if you are properly wearing the heart rate monitor. Also, spray some water on it 

before use. 

       (2) Turn on the Heart Rate Alert function. 

       (3) If it is still not working, check the battery of the Heart Rate Monitor. 
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10.) Q: How to edit and upload waypoints through the software? 

     A: To Edit Waypoints, see steps below: 

       (1) From Track Records, select the training file that you want to browse. 

       (2) Click Waypoints in the function bar and you will see all the waypoints. Right-click on 

one of the waypoints to edit its contents.  

       (3) Press the Save button when you're done. 

        To Upload Waypoints, refer to the procedures below: 

       (1) Select the waypoints that you want to transfer to the device.  

       (2) To upload, you can do this by going to Data Transmission > Way Points > Upload to 

Device.         

       (3) In the watch, please enter CONFIGURATION > CONNECT TO PC.  

       (4) Afterwards, it should show that you successfully uploaded the waypoint into the 

device. 

 

11.) Q: What formats of the training file do the software supports? 

     A: It can save or open a training record as or from the following formats: .kml, .nmea, .gpx, 

csv, and .txt.  

 To open a file, go to File > Open. Choose a certain file you want to open. 

 To save a file, select one training file you want to save. Go to File > Save. Choose a certain 

file type you want to save it as. 

 

12.) Q: How to import or export the training records from or to an activity file? 

     A: To import the training records from a specific file (.ACT): 

 Go to Main > Import Activity. Choose the file you want to import. 

 To export the training records to a specific file (.ACT): 

 Choose one training file you want to export. Go to Main > Export Activity > Activity Details. 

Input additional note. Click OK. 

 

13.) Q: Why does it always show "Application database not ready" whenever I execute the 

software? 

     A: Please try the following: 

        (1) Navigate to the Services Setting by going to START > Control Panel > System & 

Maintenance > Administrative Tools > Services. 

     (2) Find out service name MySQL1. 

     (3) Select MySQL1 and click Start to connect it. 

     (4) Please try to open up the program again. 

 

14.) Q: How do I check the firmware version of my watch? 
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     A: You can do this by going to Main Menu > Configuration > About Product. The last line 

should indicate the firmware version of your watch, in this format: F-XXX-XX-XXXXXXX. 

 

 

15.) Q: What languages are currently supported by my watch? 

     A: The languages currently supported by the watch are as follows: English, Spanish, Italian, 

France, German, Chinese, and Russian. 

 

FCC Notices  
This device complies with part 15 of the FCC rules. Operation is subject to the following two 
conditions:  
(1) This device may not cause harmful interference, and  
(2) This device must accept any interference received, including interference that may 
cause undesired operation.  
  
FCC RF Exposure requirements:  
This device and its antenna(s) must not be co-located or operation in conjunction with any 
other antenna or transmitter.  
NOTE: THE MANUFACTURER IS NOT RESPONSIBLE FOR ANY RADIO OR TV 
INTERFERENCE CAUSED BY UNAUTHORIZED MODIFICATIONS TO THIS 
EQUIPMENT. SUCH MODIFICATIONS COULD VOID THE USER’S AUTHORITY TO 
OPERATE THE EQUIPMENT. 
 


